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WORKING WITH REALPRODUCER 8 CODECS
Intended for Web professionals, intranet managers, and streaming media 
enthusiasts, this document explains RealAudio and RealVideo codecs in 
depth. It will help you use RealProducer or RealProducer Plus to create 
RealAudio and RealVideo clips that stream well and encode your source 
material faithfully.

What this Document Teaches You

You’ll learn the following from this document:

• What SureStream is, and why it won’t work with a Web server.

• What a duress stream is.

• What a codec is.

• The bit rates for RealAudio default codecs.

• How and when to change the RealAudio codecs for a target audience.

• How and when to change the RealAudio codecs used with RealVideo.

• When to use a RealVideo G2 codec instead of the RealVideo 8.0 codec.

• What RealVideo’s Scalable Video Technology (SVT) does.

• How to modify RealVideo’s maximum frame rate and streaming bit rate.

• When to use the RealVideo prefilters.

• How variable bit rate clips differ from constant bit rate clips.

• How to read RealProducer’s encoding statistics.

Requirements for Using this Document

Before you use this document, you’ll need the following:
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• Version 8 of RealProducer Basic or RealProducer Plus

This document is specific to version 8 of RealProducer. If you are using an 
earlier version of RealProducer, RealNetworks recommends that you 
upgrade to version 8. You can purchase RealProducer Plus or download 
the RealProducer Basic from 
http://www.realnetworks.com/products/index.html.

• Experience running RealProducer

This document does not provide step-by-step instructions for using 
RealProducer. It assumes that you are familiar with the RealProducer user 
interface and the procedures for encoding clips, which are described in the 
RealProducer online help, as well as RealProducer Plus User’s Guide.

• Basic Internet multimedia knowledge

You should be familiar with digitized audio and video, as well as the basic 
production techniques for creating streaming clips. You can find tips for 
these procedures in the audio and video production chapters of RealSystem 
G2 Production Guide, which is included with RealProducer Plus and 
available at http://service.real.com/help/library/encoders.html.

Note

Although many tips described here apply to Internet 
broadcasting, this document focuses on creating clips 
for on-demand delivery.

Changes in this Document Release

This technical blueprint is an update to Working with RealProducer 7 Codecs. If 
you are familiar with the earlier document, this document has only a few 
changes:

• This document discusses the new RealVideo 8.0 codec in “RealVideo 8.0” 
on page 30.

• The tables in this document reflect values for the 64 Kbps single ISDN 
target audience, which was reinstated in RealProducer 8.
2
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Choosing SureStream or Single Rate Encoding
When you encode a clip with RealProducer, the most important decision you 
make is whether to create a single-rate clip or use SureStream to generate a 
multi-rate clip. This choice is simple:

• To stream a clip with RealServer, choose SureStream.

• To host a clip on a Web server, choose the single rate option.

However, to use RealProducer effectively, you should understand what 
SureStream is. This will help you later if you decide to change the 
RealProducer encoding defaults.

What is SureStream?

Introduced with RealSystem G2, SureStream technology gives the best 
possible playback experience for different types of network connections. With 
SureStream, you can encode your source file for optimum streaming over, for 
example, 28.8 Kbps modems, 56 Kbps modems, and 112 Kbps dual ISDN 
connections, as illustrated in Figure 1. Users with 28.8 Kbps modems receive 
the stream at the lowest bit rate, while users with faster connections get a 
stream with better quality because of the extra bandwidth. RealProducer Basic 
encodes two speeds per clip, RealProducer Plus up to eight speeds.

Figure 1: SureStream Clip Encoded for Several Bandwidths

A SureStream clip can also “downshift” when a connection gets bogged down. 
Suppose a viewer starts out receiving a higher bit rate stream through a 56 
Kbps modem. If the connection starts to sputter as the network gets crowded, 
RealServer automatically downshifts to a lower bit rate stream. The audio or 
video quality drops with the lower rate stream, but the clip keeps playing. 
3
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When the interference clears, RealServer upshifts to the higher rate stream. 
RealPlayer doesn’t need to rebuffer during this shifting.

Why SureStream won’t Work with Web Servers

SureStream works only with clips streamed with RealServer. Because 
SureStream wraps several streams into a single clip, a server has to know how 
to extract just one stream from the clip. RealServer can do this, but Web 
servers, which don’t know the details of SureStream, send down all the 
encoded data for a SureStream clip rather than just one stream.

Duress Streams

Although you can encode a clip for just one connection speed with 
SureStream, you should never do this when delivering a clip with a Web server. 
Even when encoded for just one speed, a SureStream clip contains “duress” 
streams that let it downshift during network turbulence. For example, a 
SureStream music clip encoded only for 28.8 Kbps has duress streams at 16 
and 11 Kbps. A Web server downloads all these streams, wasting bandwidth.

Multiple Bandwidth Choices Through SMIL

When using a Web server, you can provide different bandwidth choices by 
encoding your source file several times for different connection speeds. You 
then provide multiple links on your Web page (one for each clip), or use 
SMIL’s <switch> tag so each RealPlayer chooses the right clip automatically. 
SMIL isn’t as flexible as SureStream, and you won’t get downshifting, but 
using SMIL makes it easier for your viewers to get the best clip for them.

Additional Information
See the SMIL chapter in RealSystem G2 Production Guide 
for instructions on using a <switch> tag.

SureStream File Size

Because each SureStream stream increases the clip’s file size, an encoded clip 
may be larger than its source file, even though the clip is compressed. If the 
clip’s file size is an issue, limit the SureStream streams to just the essential 
speeds. Table 1 gives ballpark figures for file space required for each minute of 
a RealAudio or RealVideo stream.

When using SureStream to encode RealAudio or RealVideo, add the figures 
from Table 1 for each connection speed you encode, then multiply by the 
4



RealNetworks Technical Blueprint Series Working with RealProducer 8 Codecs
length in minutes the source file plays. Table 1 shows that if you encode a 
RealAudio clip for 28.8 Kbps and 56 Kbps modems, for example, the clip takes 
about 0.39 Megabytes of disk space per minute (0.15 + 0.24). If the audio is 
five minutes long, the clip will be about 1.95 Megabytes in size (0.39 x 5).

The figure you get is an approximation based on using the RealProducer 
default settings. The actual file size varies depending on the combination of 
streams you’ve chosen, the type of audio, and whether you’ve changed the 
defaults. If you encode for just one connection speed, the file will likely be 
larger than you calculated because of the duress streams. When you encode 
RealVideo for multiple connections, the file size may be lower than you 
calculated because different RealVideo streams may use the same RealAudio 
stream for a soundtrack.

Working with RealAudio Codecs
All streaming audio and video clips use some type of codec, which is short for 
“coder/decoder.” Codec software tells a computer how to compress or 
decompress a clip. RealProducer uses RealAudio and RealVideo codecs to 
convert audio and video input to RealAudio and RealVideo clips that stream 
at a certain bandwidth. On the receiving end, RealPlayer uses the same codecs 
to expand the streaming clips into digitized audio and video data that the 
computer can play.

RealAudio employs a series of codecs, each of which uses a precise amount of 
bandwidth when a clip streams. One RealAudio codec compresses mono 
music for a 28.8 Kbps modem. Another compresses stereo music for that same 
modem speed. This set of codecs is different from the set used to compress 

Table 1: Approximate Size for RealAudio and RealVideo Clips

Target Audience RealAudio RealVideo

28.8 Kbps modem 0.15 Megabytes/minute 0.15 Megabytes/minute

56 Kbps modem 0.24 Megabytes/minute 0.25 Megabytes/minute

64 Kbps single ISDN 0.32 Megabytes/minute 0.33 Megabytes/minute

112 Kbps dual ISDN 0.47 Megabytes/minute 0.59 Megabytes/minute

Corporate LAN 0.70 Megabytes/minute 1.1 Megabytes/minute

256 Kbps DSL/cable modem 0.70 Megabytes/minute 1.65 Megabytes/minute

384 Kbps DSL/cable modem 0.70 Megabytes/minute 2.56 Megabytes/minute

512 Kbps DSL/cable modem 0.70 Megabytes/minute 3.30 Megabytes/minute
5
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music for, say, cable modems. “RealAudio Codec Reference” on page 16 lists 
the many RealAudio codecs RealProducer uses.

When you encode RealAudio with RealProducer, you select target audience 
speeds and indicate the audio type, whether voice, voice with music, mono 
music, or stereo music. By doing this, you tell RealProducer which RealAudio 
codec or codecs to use. That’s why you need to answer RealProducer’s 
questions correctly. Encoding with the wrong codec may degrade a clip’s 
sound quality. Using a codec intended for voice on a music clip forces, as it 
were, a square peg through a round hole.

RealAudio squeezes files down by, in part, throwing out data, which makes 
RealAudio a lossy compression format. RealAudio doesn’t delete data 
indiscriminately, though. It first jettisons portions you can’t hear, such as very 
high and very low frequencies. Next, it removes as much data as needed while 
keeping certain frequencies intact. Your answer to the audio type question 
(voice, music, or a combination) determines which frequencies stay and which 
go. Voice encoding favors frequencies in the normal human speaking range. 
Music encoding retains a broader frequency range.

Although RealProducer is savvy about what audio data it throws out, you 
can’t escape the reality that the lower the connection speed, the more data gets 
ejected, and the cruder the sound quality becomes. At low bandwidths, you get 
roughly the quality of an AM radio broadcast. With faster connections, you 
can encode music with FM-quality sound. And at the high speeds of DSL, 
cable modems, and LANs, RealAudio rivals CD playback.

Encoding with the RealAudio Standard Defaults

Out of the box, RealProducer is set up to use a specific set of RealAudio codecs 
based on your choice of:

• target audience speed (dial-up modem, DSL/cable, and so on), and

• audio type (voice, voice with music, mono music, or stereo music).

Table 2 shows the bit rates at which RealProducer encodes a RealAudio file 
based on your choice of connection speed and audio type. With voice-only 
clips encoded for a 28.8 Kbps modem, for example, you get a 16 Kbps 
streaming clip. With mono music, though, you get a 20 Kbps streaming clip.
6
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Notice that RealAudio doesn’t use all of a connection’s available bandwidth. 
For 28.8 Kbps modems, RealAudio uses 16 or 20 Kbps, reserving some 
bandwidth for network overhead. You can never push a full 28.8 Kbps of 
usable data through a 28.8 Kbps modem. Although the same is true for all 
connections, higher-speed connections need proportionally less bandwidth for 
overhead than analog modems, which are more prone to transmission errors.

At low speeds, RealAudio uses most of the connection bandwidth to make the 
audio quality as high as possible. At faster speeds, RealAudio uses less of the 
connection’s total bandwidth. The fastest RealAudio codec is 96 Kbps, which 
is less than half the usable bandwidth of a 256 Kbps connection. Note, too, 
that every RealAudio codec has a specific speed. There are 64 Kbps and 96 
Kbps codecs, for example, but nothing in-between. These are the factory 
settings, and you can’t make RealAudio stream at, say, 75 Kbps.

Choosing SureStream Rates with RealProducer Basic

Getting a handle on the RealAudio codecs used with RealProducer’s target 
audience speeds helps you use SureStream effectively. If you use RealProducer 
Basic, you get just two audience choices, so you should make the most of 
them. Table 2 tells you not to choose the 28.8 and 56 Kbps modem audiences 
when encoding a voice-only clip, for instance. If you do, RealProducer creates a 
single 16 Kbps stream for both audiences. It’s better to choose one of the 
modem settings (it doesn’t matter which) and one of the higher bandwidth 
settings. This gives you a clip with a 16 Kbps stream for slower connections, 
and a 32 or 64 Kbps stream for faster connections.

Table 2: RealAudio Standard Default Bit Rates

Target Audience Voice Only
Voice and 
Music

Mono
Music

Stereo
Music

28.8 Kbps modem
16 Kbps

16 Kbps 20 Kbps 20 Kbps

56 Kbps modem
32 Kbps

32 Kbps 32 Kbps

64 Kbps single ISDN 32 Kbps 44 Kbps 44 Kbps

112 Kbps dual ISDN

64 Kbps 64 Kbps 64 Kbps

64 Kbps

Corporate LAN

96 Kbps
256 Kbps DSL/cable modem

384 Kbps DSL/cable modem

512 Kbps DSL/cable modem
7
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With music, though, you need to determine which audiences to leave out. For 
mono music, a 28.8 Kbps modem gets 20 Kbps of sound, while a 56 Kbps 
modem gets 32 Kbps. That extra 12 Kbps of bandwidth noticeably improves 
sound quality. So if modem audiences are important, encode with the two 
modem settings. If you want to provide higher-quality clips for faster 
connections, choose one modem audience to get a slower clip (16, 20, or 32 
Kbps), and a higher-speed connection to get a faster clip (44, 64, or 96 Kbps). 
Just remember not to choose two audiences that get the same stream.

Choosing SureStream Rates with RealProducer Plus

If you purchase RealProducer Plus, you can encode RealAudio for all eight 
target audience speeds. It doesn’t hurt to choose all the audiences, but you 
won’t ever get eight distinct and separate streams. As shown in Table 2 above, 
many target audiences share the same stream. RealProducer is smart enough 
to know that if you choose different audiences that use the same codec, you 
need just one stream that uses that codec. It won’t waste file space and 
processor time by stuffing two identical streams into the same clip.

In Table 2, notice that RealProducer Plus gives you, at most, five SureStream 
streams per RealAudio clip. Aren’t you’re supposed to get up to eight? This 
isn’t a marketing ploy, as you’ll see with RealVideo, which differs greatly in 
encoding speed for each target audience. And as described in “Changing 
RealAudio Defaults” on page 12, you can modify the RealAudio default 
settings to get different streaming rates for each target audience.

Reducing Streaming Clip Size

Just because RealProducer Plus lets you encode for all eight target audiences, 
that doesn’t mean you have to. Other factors such as clip size might matter. 
Each SureStream stream increases the clip’s size as shown in Table 1 on page 5. 
If the audio file is large, the encoded clip size can escalate dramatically. The 
bigger the clip, the more hard disk space it eats up, and the longer it takes to 
transfer to RealServer. If you need to reduce the clip size, Table 2  on page 7 
helps you intelligently select which connection speeds to leave out.

Suppose you’re encoding stereo music. You want to cut down the file size, and 
the music quality is fine at medium bandwidths. Table 2 tells you to leave out 
the LAN and DSL/cable modem options. Just leaving out one of these options 
won’t help because they all use a 96 Kbps stream. Leaving them all out 
eliminates the 96 Kbps stream, reducing the clip size quite a bit. Users with 
these fast connections get the 64 Kbps stream, which still has good quality. If 
8
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clip quality is all important, though, you may want to keep the 96 Kbps 
stream to wring out as much fidelity as you can get.

Of course, you don’t have to eliminate the higher bit rate stream. In some 
cases, you may want to eliminate an intermediate stream. Take a look at the 
“voice and music” column of Table 2. To cut down the clip size, you might 
leave out the 56 Kbps modem and 64 Kbps single ISDN audiences. Users at 
these speeds would then get the 16 Kbps clip, the same one 28.8 Kbps modem 
users get. The clip would have a 16 Kbps and a 64 Kbps stream for higher 
speeds. As you see, reducing SureStream file size is a balancing act based on 
which audiences are important to you.

Encoding with the RealAudio Multimedia Defaults

Table 2 on page 7 shows you which RealAudio codecs RealProducer uses as its 
standard default settings. RealProducer has another set of defaults, though, that 
lower a RealAudio clip’s streaming bandwidth so you can combine it with 
other clips in a multimedia presentation. To use the multimedia defaults, 
choose the menu command Options>Target Audience Settings>for RealAudio 
Clips.... This displays the dialog shown in Figure 2.

Figure 2: RealAudio Target Audience Dialog
9
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Initially, the radio button Audio Only is selected. This sets RealProducer to use 
RealAudio’s standard defaults given in Table 2. If you click  Multimedia 
Presentation, RealProducer uses lower-bandwidth RealAudio codecs for each 
combination of audience and music type. This keeps RealAudio from 
overloading the connection when played in parallel with another clip in a 
SMIL presentation. These settings stay in effect until you click the Audio Only 
button to return RealProducer to the standard defaults.

Table 3 shows the results of encoding a RealAudio clip with the multimedia 
defaults. With these defaults turned on, encoding voice-only audio for a 28.8 
Kbps modem produces an 8.5 Kbps clip, for example. The standard default 
given in Table 2 is a 16 Kbps clip. In most cases, a clip using the multimedia 
defaults consumes about half the standard default bandwidth. The “Top 
Speed” column in Table 3 shows the total usable bandwidth for each 
connection. Your multimedia presentation should not exceed this number.

Tip
When you use RealProducer Basic, the same audience 
choice strategies discussed in “Choosing SureStream 
Rates with RealProducer Basic” on page 7 apply to using 
the multimedia defaults.

When to Use the Multimedia Defaults

Using the multimedia defaults is crucial for delivering multliclip 
presentations at slow connection speeds. Suppose you want to deliver a 
combined RealPix slideshow and RealAudio narration over a 28.8 Kbps 
modem. For this modem speed, presentations should not exceed 20 Kbps. If 

Table 3: RealAudio Multimedia Default Bit Rates

Target Audience Top Speed Voice Only
Voice and
Music

Mono
Music

Stereo
Music

28.8 Kbps modem 20 Kbps 8.5 Kbps 8.5 Kbps 8 Kbps 8 Kbps

56 Kbps modem 34 Kbps
16 Kbps

16 Kbps 20 Kbps 20 Kbps

64 Kbps single ISDN 45 Kbps

32 Kbps

32 Kbps 32 Kbps112 Kbps dual ISDN 80 Kbps

32 Kbps

Corporate LAN 150 Kbps

256 Kbps DSL/cable 225 Kbps

64 Kbps

64 Kbps

384 Kbps DSL/cable 350 Kbps
96 Kbps

512 Kbps DSL/cable 450 Kbps
10
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you use the standard RealAudio settings, you get a 16 Kbps RealAudio clip, 
leaving just 4 Kbps for RealPix. That’s inadequate for most slideshows. If you 
use the RealAudio multimedia settings, though, you get an 8.5 Kbps clip. That 
nearly triples the amount of bandwidth for RealPix to 11.5 Kbps.

At faster speeds, though, it’s not always necessary to encode RealAudio at the 
multimedia rate for a multiclip presentation. Just make sure your RealAudio 
clip uses a lot of SureStream streams, and let each RealPlayer determine which 
stream to play. When clips play together, RealPlayer evaluates their separate 
requirements, assesses its own connection speed, and determines if it can 
juggle all the clips together. With a SureStream clip, RealPlayer automatically 
picks the highest bit rate stream it can handle while still keeping all the other 
balls in the air.

For example, suppose you have a RealPix clip at 12 Kbps. You could have it 
play in parallel with a RealAudio mono music clip encoded with the standard 
defaults for 28.8 Kbps and 56 Kbps modems. Table 2 on page 7 shows that you 
get two audio streams, one at 20 Kbps and one at 32 Kbps. The combined 
RealPix and RealAudio presentation is too fast for a 28 Kbps modem. For a 56 
Kbps modem, though, RealPlayer chooses the 20 Kbps RealAudio stream, 
putting the presentation at 32 Kbps (20 Kbps for RealAudio plus 12 Kbps for 
RealPix). Faster connections get the 32 Kbps RealAudio stream.

In some cases the multimedia defaults are the same as the standard defaults, 
so it doesn’t matter which set of defaults you use. For DSL/cable modem 
connections, for example, mono music is recorded at 64 Kbps regardless of 
which defaults you use. The same is not true for stereo music with the 256 
Kbps DSL/cable modem audience, though. The standard default is 96 Kbps 
while the multimedia default is 64 Kbps.

Even when the rates differ between the standard and multimedia defaults, you 
may want to stick with the standard defaults when you have bandwidth to 
burn. Look at the voice-only speeds for the DSL/cable modem settings, for 
instance. The multimedia rates are 32 Kbps, while the standard rates are 64 
Kbps. But the presentation top speed is a whopping 225 to 450 Kbps. When 
pairing RealAudio with a RealPix clip that streams at 40 Kbps, for example, 
you can encode your soundtrack with standard defaults, getting a 64 Kbps 
RealAudio rate. At a combined speed of 104 Kbps, your presentation will have 
plenty of bandwidth to spare on DSL and cable modem connections.

RealAudio, it’s important to grasp, is the most inflexible media type in terms 
of bandwidth use. Bandwidth choices are in a stairstep model: 20 Kbps, 36 
Kbps, 44 Kbps, and so on, with no in-between choices. So when you plan to 
11
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use RealAudio in a multimedia presentation, decide which bandwidth or 
bandwidths you want the audio clip to use. Then create your other clips to 
stream within the bandwidth that’s left.

Tip

Remember not to count on having the connection’s full 
speed (such as 28.8 Kbps) available. Always use as your 
maximum the top speed given in Table 3.

Changing RealAudio Defaults

If you own RealProducer Plus, you can choose exactly which RealAudio codec 
RealProducer uses for any combination of audience and audio type. You can’t 
do this with RealProducer Basic, however. So if you want to become the 
ultimate power user, you’ll need to upgrade.

To change the defaults, choose Options>Target Audience Settings>for 
RealAudio Clips... to display the dialog shown in Figure 2 on page 9. Click the 
Audio Only radio button to change the standard codecs, or the  Multimedia 
Presentation button to change the codecs used for clips combined with other 
media. Next, select the connection speed in the Target Audience pull-down 
menu. The four pull-down menus in the remainder of the dialog let you set 
the target audience’s codec for each type of audio:

• voice

• voice with music

• mono music 

• stereo music

Because you can change any RealAudio default codec choice, there’s nothing 
immutable about the target audience and audio type combinations. When you 
encode a clip, selecting voice-only audio for 28.8 Kbps modems might give you 
a stereo music clip for DSL connections because you’ve changed the defaults. 
This makes changing the defaults a powerful tool, but also a potentially 
confusing one if you forget how you’ve adjusted codec selection. Keep in mind, 
too, that you can choose between two distinct sets of defaults by clicking 
either the Audio Only or the Multimedia Presentation radio button.
12
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Tip
Click Restore Defaults to return all settings to their 
defaults. This affects both the standard and the 
multimedia default settings.

Additional Information
The statistics that RealProducer shows after creating a 
clip help you verify that the clip is encoded the way you 
want. See “Viewing Statistics” on page 35.

Changing RealAudio Defaults for Different Bandwidths

The most obvious reason to change the RealAudio defaults is to modify the 
streaming speed for a certain target audience and audio type. This is most 
useful for multiclip presentations. As noted above, you might not want to use 
RealAudio’s reduced multimedia rates at higher connection speeds because 
the standard defaults leave plenty of bandwidth for other clips. (That’s rarely 
true at slow speeds, though.) So you might leave the multimedia defaults for 
slow connection speeds at their presets, and use faster codecs for higher 
connection speeds.

Even if you want reduced RealAudio bandwidths at higher speeds, changing 
the multimedia defaults lets you target exactly which codec to use. Look at the 
mono music rates for the LAN and DSL/cable modem connections listed in 
Table 2 on page 7 and Table 3 on page 10. The streaming rate with the 
standard defaults is a 64 Kbps. The multimedia rate weighs in at half that size: 
32 Kbps. Between those two is a 44 Kbps mono music codec. If you’re creating 
a presentation at 100 Kbps, and you want the best audio possible, you might 
bump the multimedia rate up to 44 Kbps as long as 56 Kbps is enough for the 
other clips.

Note

Always keep in mind the top streaming speed for 
connections as shown in Table 3 back on page 10.

Encoding High Response Music

The 20 Kbps and 32 Kbps mono music codecs both come in two flavors. 
RealProducer by default uses the “high response” versions, which are the 
better codecs for most situations. But you can also use the “normal response” 
13
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versions. Table 4 lists the high response codecs and their normal response 
twins.

The high response codecs cover a larger frequency spectrum than the normal 
response versions. As you can see with the 20 Kbps codecs, the high response 
version has twice the range as the normal codec. This means it provides crisper 
sound and is better at capturing high frequencies. With symphonic music, for 
example, the high response codec gets more of the flute and piccolo. It can 
produce more distortion than the normal response codec with voices and loud 
sounds such as drums, though.

If you’re encoding music with a diverse range of frequencies, stick with the 
high response codecs. If you notice distortion, compare your results with a clip 
that uses the normal response codecs. The best tool for determining which 
codec to use is your ear. Listen carefully for minute differences in how the clip 
sounds. It also helps to have other people listen. Our own ears have different 
frequency responses, too.

Making a Mono Clip from Stereo Input

Take a look back at the mono and stereo music settings in Table 2  on page 7. 
Until you get to the high speed connections, the mono and stereo bit rates are 
the same. What isn’t the same, though, is the quality. Mono music has one 
channel that gets sent to both speakers. Stereo music has separate channels 
for the left and the right. That means a stereo version of an audio clip holds 
twice as much data as a mono version. Yet RealProducer makes stereo and 
mono clips the same size. How can it do this?

The answer lies in the codecs’ frequency responses. Remember, RealAudio is a 
lossy compression scheme that throws out data. The stereo codec squeezes 
both channels down to the same size as the mono codec by throwing out more 
data for each channel. This makes its frequency response lower. To put it 
simply, a stereo clip doesn’t represent all frequencies as accurately as a mono 

Table 4: RealAudio High and Normal Response Codecs

Codec Speed Frequency Response

20 Kbps Music 20 Kbps 10 kHz

20 Kbps Music—High Response 20 Kbps 20 kHz

32 Kbps Music 32 Kbps 16 kHz

32 Kbps Music—High Response 32 Kbps 20 kHz
14
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clip. You’ll hear the two channels, but they may not sound as crisp as a mono 
channel.

The lower frequency response is not necessarily a bad thing. If the music falls 
within the codec’s response range, the mono and stereo clips won’t differ 
greatly (except with stereo you get the two channels). If a stereo clip sounds 
muddy, try encoding the audio source as a mono clip. RealProducer is smart 
about the stereo-to-mono conversion. It doesn’t simply throw out a channel as 
some audio programs do. Instead, it blends the two channels into the mono 
channel. This is called “panning to the middle.” If it didn’t do this, a musical 
instrument recorded on only the left or right channel might simply vanish 
from the recording!

Tip
If you’re a pro or budding audiophile, run the stereo-to-
mono conversion in your audio editing program so you 
have full control over the result.

Additional Information
“RealAudio Codec Reference” on page 16 lists each 
RealAudio codec’s frequency response.

Using Mono at Low Speeds, Stereo at High Speeds

Stereo encoding steps into the limelight at higher bandwidths. The higher the 
streaming speed, the better the stereo frequency response. You may find that 
the best compromise is to provide mono music at low bandwidths, stereo 
music at high bandwidths. You can do this by producing two different 
versions of your audio file. Or you can change the RealProducer Plus defaults 
to encode stereo music as mono at low speeds and as stereo at high speeds 
where the stereo codec frequency response is greater.

If you stick with the stereo codecs at higher connection speeds, SureStream 
clips are stereo when bandwidth is plentiful, mono when it’s sparse. If the clip 
has to downshift from high to lower speeds, the music shifts from stereo to 
mono, but the sound stays brighter. You might change the 28.8 and 56 Kbps 
default targets for stereo music to use the 20 Kbps and 32 Kbps mono codecs, 
for example. Figure 3 illustrates changing the 28.8 Kbps stereo music target 
from stereo to mono. Note how the frequency response doubles.
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Figure 3: Mono Encoding for Stereo Audio at for 28.8 Kbps Modems

Additional Information
“Changing RealAudio Defaults” on page 12 explains 
how to change the default codec selections. “RealAudio 
Codec Reference” on page 16 lists the frequency 
response of each codec.

RealAudio Codec Reference

This section provides a reference for all RealAudio codecs used by 
RealProducer, broken down into separate tables for voice, mono music, and 
stereo music codecs. There are no separate voice-with-music codecs. When you 
choose voice with music, RealProducer uses a voice codec. Each table lists each 
codec’s optimum sampling rate and frequency response.

Using a codec’s optimum sampling rate in your audio source file ensures that 
the audio stays synchronized with other media and prevents pitch shifting in 
audio resampling. Audio quality degrades if you use lower than the optimum 
sampling rate. If you use a higher sampling rate, it is best to use a multiple of 
the optimum rate. If the optimum rate is 8 kHz, for example, use a higher rate 
of 16 kHz or 32 kHz. When in doubt, use a CD-quality sampling rate of 44.1 
kHz.

The frequency response column lists the codec’s frequency response in 
Kilohertz. A codec with a higher frequency response reproduces a wider range 
of sound than a codec with a lower response. A measure of codec quality, the 
frequency response does not affect how you produce audio. RealAudio 
encoding always results in a clip of equal or lower quality than the original 
audio. If the original audio has an 8 kHz frequency response, encoding it with 
a codec that has a frequency response of 10 kHz produces a clip that still has a 
response of 8 kHz.
16
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Additional Information
The audio preparation chapter of RealSystem G2 
Production Guide has an expanded list that covers all 
RealAudio codecs, including obsolete codecs no longer 
used by RealProducer.

Voice Codecs

RealProducer uses a voice codec when you encode a voice-only or voice-with-
music clip. The lowest-speed voice codec normally used with RealAudio is 16 
Kbps. The lower-speed codecs are used as “duress” streams in SureStream 
clips. They’re also used to encode soundtracks for low-bandwidth RealVideo 
clips.

Mono Music Codecs

As with the voice codecs, the lowest-speed mono music codec normally used 
with RealAudio is 16 Kbps. The lower-speed codecs are used as “duress” 
streams in SureStream clips, and to encode soundtracks for low-bandwidth 
RealVideo clips. When there are two versions of a codec, RealProducer uses the 
high response version by default. 

Table 5: RealAudio Voice Codecs

RealAudio Codec Sampling Rate Frequency Response

5 Kbps Voice 8 kHz 4 kHz

6.5 Kbps Voice 8 kHz 4 kHz

8.5 Kbps Voice 8 kHz 4 kHz

16 Kbps Voice 16 kHz 8 kHz

32 Kbps Voice 22.05 kHz 11 kHz

64 Kbps Voice 44.1 kHz 20 kHz

Table 6: RealAudio Mono Music Codecs

RealAudio Codec Sampling Rate Frequency Response

6 Kbps Music 8 kHz 3 kHz

8 Kbps Music 8 kHz 4 kHz

11 Kbps Music 11.025 kHz 5.5 kHz

16 Kbps Music 22.05 kHz 8 kHz

20 Kbps Music 22.05 kHz 10 kHz
 (Table Page 1 of 2)
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Stereo Music Codecs

The slowest stereo codec is 20 Kbps. Stereo codecs don’t go lower than that 
because they would not have enough frequency response for adequate sound. 
You can always encode stereo music with a lower-speed mono codec, though. 
RealProducer converts the music to mono for you. Don’t encode mono music 
with a stereo codec, though. You don’t get stereo music, just a lowered 
frequency response.

Working with the RealVideo Codec
A video consists of two parts: the visual track and the soundtrack. For the 
soundtrack, RealProducer uses the RealAudio codecs. For the visual track, it 
uses a RealVideo codec. It packages both tracks in a single RealVideo file that, 
like RealAudio, uses the file extension .rm. So keep in mind that everything 
discussed about RealAudio clips in “Working with RealAudio Codecs” starting 
on page 5 applies to the soundtrack of RealVideo clips.

Unlike RealAudio, RealVideo uses just one codec to compress a video’s visual 
track for all bandwidths. For all practical purposes, the RealVideo codec is 
infinitely scalable. You can encode RealVideo at any speed you want, from 20 

20 Kbps Music—High Response 44.1 kHz 20 kHz

32 Kbps Music 44.1 kHz 16 kHz

32 Kbps Music—High Response 44.1 kHz 20 kHz

44 Kbps Music 44.1 kHz 20 kHz

64 Kbps Music 44.1 kHz 20 kHz

Table 6: RealAudio Mono Music Codecs (continued)

RealAudio Codec Sampling Rate Frequency Response

 (Table Page 2 of 2)

Table 7: RealAudio Stereo Music Codecs

RealAudio Codec Sampling Rate Frequency Response

20 Kbps Stereo Music 11.025 kHz 5 kHz

32 Kbps Stereo Music 22.05 kHz 8 kHz

44 Kbps Stereo Music 22.05 kHz 11 kHz

64 Kbps Stereo Music 44.1 kHz 16 kHz

96 Kbps Stereo Music 44.1 kHz 20 kHz
18



RealNetworks Technical Blueprint Series Working with RealProducer 8 Codecs
Kbps to hundreds of kilobits per second. Plus you can encode at precisely any 
bandwidth you choose, such as 65 Kbps, 89 Kbps, 117 Kbps, and so on.

Because RealVideo uses RealAudio for audio, a specific amount of the clip’s 
bandwidth goes to the soundtrack. The visual track then gets squeezed into 
the remaining bandwidth. Like RealAudio, RealVideo compression is “lossy,” 
meaning RealProducer throws out video data when necessary as it encodes a 
clip. RealVideo does this intelligently to keep the clip’s playback quality as 
high as possible.

RealProducer squeezes down clip size by, in part, reducing the video’s frame 
rate. Most videos have a frame rate from 15 to 30 frames per second (fps). 
RealProducer dynamically adjusts this frame rate downward, keeping the rate 
up where there’s a lot of movement, reducing it in slow scenes. If you follow 
good production techniques, your clips will typically stream over slow to 
medium-speed connections at 5 to 15 fps, depending on the video quality and 
the target audience. At higher speeds, you’ll get 15 to 30 fps.

Another way RealVideo reduces the clip’s streaming size is to throw out pixel 
data. A standard video clip stores information about each screen pixel in the 
video frame. Instead of storing unique values for each pixel, RealVideo stores 
data for pixel groups. When bandwidth is tight, RealProducer shoehorns 
pixels with slightly different RGB values into the same group. These pixels end 
up looking identical rather than nearly identical. This results in a loss of 
detail, which can distort the video. Figure 4 compares a smooth video with a 
version that has lost detail through encoding for a low bandwidth.

Figure 4: Smooth and Distorted Video

The different means of reducing video bit rate explain why RealProducer asks 
you whether you prefer smooth motion (a higher frame rate), better image 
quality (more detail), or a split of the difference. Your choice tells it how to 
squeeze down the file data. As it creates the RealVideo clip, RealProducer also 
uses some complex technology to soften the blow of the reduced frame rate 
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and pixel data. This helps smooth jerkiness and sand off the rough edges of 
the pixel blocks.

Encoding Clips with the RealVideo Defaults

RealProducer determines how to encode a RealVideo clip based on your 
selection of:

• target audience speed (dial-up modem, DSL/cable modem, and so on),

• audio type (voice, voice with music, mono music, or stereo music), and

• video quality preference (smooth motion, clear image, a combination of 
the two, or a slide show).

Table 8 shows the RealAudio codecs used for RealVideo clips based on 
connection speed and audio type.

The first column in Table 8 lists RealProducer’s standard target audiences. For 
each audience, the “Top Speed” column shows the maximum streaming 
bandwidth. For 28.8 Kbps modems, for example, RealProducer creates a 
RealVideo clip at 20 Kbps. As it does when creating a RealAudio clip, 
RealProducer never uses the full connection bandwidth, reserving some 
bandwidth for overhead.

The remaining four columns show which RealAudio codec RealProducer uses 
in the RealVideo clip, depending on the audio type. Compare these rates to 
those in Table 2 on page 7. Table 2 shows that when you encode mono audio 
for a 28.8 Kbps modem, you get a 20 Kbps RealAudio clip. But Table 8 shows 

Table 8: RealVideo Bit Rates

RealAudio Rate

Target Audience Top Speed Voice Only
Voice and 
Music

Mono
Music

Stereo
Music

28.8 Kbps modem 20 Kbps
5 Kbps 6.5 Kbps 8 Kbps 8 Kbps

56 Kbps modem 34 Kbps

64 Kbps single ISDN 45 Kbps
8.5 Kbps 8.5 Kbps

11 Kbps 11 Kbps

112 Kbps dual ISDN 80 Kbps 16 Kbps 20 Kbps

Corporate LAN 150 Kbps

32 Kbps 32 Kbps

32 Kbps 32 Kbps

256 Kbps DSL/cable 225 Kbps
44 Kbps

44 Kbps

384 Kbps DSL/cable 350 Kbps 64 Kbps

512 Kbps DSL/cable 450 Kbps 64 Kbps 96 Kbps
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that the same audio gets 8 Kbps of bandwidth when used in a video clip. Even 
at fast speeds, a RealVideo soundtrack gets about half the bandwidth it would 
receive when encoded solo as RealAudio. So, for example, a music video won’t 
sound as good as the music alone.

The amount of bandwidth used for the visual track is the total rate minus the 
RealAudio soundtrack rate. For a 28.8 Kbps modem, the visual track gets 15 
Kbps (20 Kbps minus 5 Kbps) when the audio is voice-only, 13.5 Kbps (20 
Kbps minus 6.5 Kbps) when it’s voice with music, or 12 Kbps (20 Kbps minus 
8 Kbps) when it’s music. A video with an audio narration might therefore look 
slightly better than one with a music soundtrack because more bandwidth 
goes to its visual track. At higher connection speeds, though, the differences 
even out. Many things, though, affect a video clip’s quality, and even a music 
video can look good at 20 Kbps.

Additional Information
For more on video quality, see the video preparation 
chapter in RealSystem G2 Production Guide.

Note, too, that the lowest-speed stereo codec is 20 Kbps. Table 8 shows that 
stereo codecs 20 Kbps or faster are used only for RealVideo clips encoded at 
dual ISDN or faster speeds. When you encode for lower connection speeds, 
RealProducer converts stereo sound to mono because bandwidth is lacking for 
both the visual track and a stereo soundtrack. “Making a Mono Clip from 
Stereo Input” on page 14 explains more about this conversion process.

Changing the RealAudio Codecs used with RealVideo

If you have RealProducer Plus, you can change the RealAudio codecs 
RealProducer uses for video clips. This lets you increase or decrease the 
soundtrack bandwidth to emphasize or de-emphasize it in relation to the 
visual track. To change the defaults, choose Options>Target Audience 
Settings>for RealVideo Clips..., and click the Audio tab. The dialog is similar to 
the one used to modify RealAudio defaults, as shown in Figure 2 on page 9. 

To change the RealAudio codec used with a certain RealVideo stream, select 
the target audience speed in the Target Audience pull-down menu. The four 
pull-down menus in the remainder of the dialog correspond to the audio type 
choices: voice, voice with music, mono music, and stereo music. For an audio 
type, simply select the appropriate codec from the pull-down menu. Click OK 
when you’re finished.
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Note

Each tab of the RealVideo preferences dialog has a 
Restore Defaults button that returns everything to the 
initial defaults. This affects all panes in the dialog, not 
just the one you’re viewing.

When to Modify the Audio Bandwidth in RealVideo

The reasons for swapping RealAudio codecs given in “Changing RealAudio 
Defaults” on page 12 applies to changing the audio defaults for RealVideo as 
well. When you encode a video, you might want to change its stereo 
soundtrack to mono to get better frequency response at low bandwidths. Or 
you might want to use the 20 Kbps and 32 Kbps normal response codecs.

The primary reason to change the defaults, though, is to increase or decrease 
the bandwidth used by the video’s soundtrack. In most cases, you won’t want 
to decrease the soundtrack’s bandwidth. As Table 8 on page 20 shows, the 
defaults are low to start. This ensures that the visual track gets enough 
bandwidth while keeping audio quality acceptable. For high-speed 
connections, though, you may want to increase the soundtrack bandwidth to 
get better sound quality.

An example of when to increase audio bandwidth is a music video streamed at 
high speeds. At the 256 Kbps DSL/cable modem speed, you may want to use a 
64 Kbps RealAudio codec instead of 32 or 44 Kbps, for instance. This boosts 
sound quality greatly without cutting too hard into video clarity and frame 
rate. If in doubt, try different options and determine by sight and sound 
which clip best balances audio and visual quality.

Modifying RealVideo’s Frame Rate

The default, maximum frame rate for RealVideo clips is 15 frames per second 
(fps) for dial-up modem and ISDN audiences, 30 fps for LAN/DSL/cable 
modems. During encoding, RealProducer adjusts the frame rate based on the 
clip size, target audience speed, and emphasis on smoothness or visual clarity. 
One scene may be 7 fps, for example, while another is 10. A maximum of 15 
fps means the frame rate may vary anywhere between 15 fps and 0.25 fps.

It’s a good strategy to leave the maximum frame rates set to their defaults and 
let RealProducer cut rates down as needed. At low bandwidths, though, you 
may want to emphasize clarity. Instead of just choosing the RealProducer 
option for visual clarity, you could also set a slower maximum frame rate, say 5 
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fps. This slows the frame rate even when it could go faster. The result is a 
sharper image, at the expense of some jerkiness due to the slower frame rate. 
Rarely would you want to increase the maximum frame rate unless you’re also 
raising the streaming bit rate as described below.

Tip
To really slow things down and heighten visual clarity, 
you can just record the video as a slide show. You’ll get 
about one frame a second without having to lower the 
frame rate setting.

You can change the maximum rate with Options>Target Audience Settings>for 
RealVideo Clips.... After giving this command, click the Video tab, which is 
shown in Figure 5. Select the connection speed in the Target Audience pull-
down menu. Then click the slider button and move it between the minimum 
of 0.25 fps and the maximum of 30 fps. The chosen frame rate displays to the 
left of the slider.

Figure 5: RealVideo Maximum Frame Rate Dialog

Changing RealVideo’s Target Bit Rate

Unlike RealAudio codecs, which have fixed bit rates, the RealVideo codec can 
squeeze the visual track into any bandwidth. Only the soundtrack bit rate is 
fixed, based on the RealAudio codec used. To change RealVideo’s total 
streaming speed, select Options>Target Audience Settings>for RealVideo 
Clips.... Then click the Target Bitrate tab, which is shown in Figure 6. This tab 
lets you change the total RealVideo bit rate by selecting the connection speed 
in the Target Audience pull-down menu, and entering a bit rate in Kilobits per 
second in the Target Bitrate field. Click OK when you’ve made your changes.
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Figure 6: RealVideo Target Bit Rate Dialog

The main reason to lower the streaming bit rate of a RealVideo clip is to 
combine it with another clip at lower bandwidths. But remember that 
lowering the RealVideo bit rate affects its quality. Video is hungry for speed, 
and you need to leave enough bandwidth for RealVideo to function well. You 
generally shouldn’t need to raise the bit rates because they are as high as they 
can safely go for each target audience. The following sections give tips for 
handling RealVideo bandwidth settings.

Additional Information
See the “Top Speed” column of Table 8 on page 20 for 
the recommended maximum bandwidth of a 
presentation streamed to various audiences.

Don’t Lower RealVideo Speeds for 28.8 Kbps Modems

Don’t touch the setting for 28.8 Kbps modems. The default size of 20 Kbps is 
the smallest package that can carry video. Lowering the size seriously degrades 
quality. So for slow modems, don’t try to combine RealVideo with other clips, 
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except a lightweight RealText clip that consumes 1 Kbps or less. In this case, 
you don’t need to lower the RealVideo bandwidth from 20 Kbps because 
RealText can easily sneak inside the extra 8.8 Kbps left for modem overhead.

Set Audio Bandwidth for a RealVideo Clip Separately

Whenever you lower RealVideo speed, the new bit rate includes the rate of the 
RealAudio codec set through the dialog’s  Audio tab. If you use a 32 Kbps 
RealAudio codec and set a total RealVideo bit rate of 36 Kbps, you won’t get 
much for the visuals, maybe a frame every few seconds. You’ll need to select a 
lower-bandwidth RealAudio codec, too.

There are no strict rules for the ratio of soundtrack bandwidth to total 
RealVideo bandwidth. The ratio can be anything depending on whether you 
want to emphasize audio or the visuals. As you can see from Table 8 on page 
20, RealVideo normally allots no more than 1/4 of the total bandwidth to the 
soundtrack because the visual information contains much more data. At high 
bandwidths, the soundtrack can receive considerably less bandwidth in 
proportion to the visual track.

Additional Information
See “Changing the RealAudio Codecs used with 
RealVideo” on page 21.

Keep the LAN Manager Happy

When streaming video on an intranet, you can raise RealVideo’s LAN 
connection bit rate because a local area network has total bandwidth much 
higher than 150 Kbps. However, LAN bandwidth is shared by everyone logged 
on. If lots of people view your RealVideo clips simultaneously, the LAN can 
bog down and no one is going to be happy, least of all the LAN manager. So in 
some cases, you may need to lower the LAN audience bit rate. What to set for 
the LAN rate depends on the LAN speed and average RealVideo use. Your LAN 
manager is the best person to determine this.

Encode for Different Target Audiences in Some Cases

Instead of lowering the bit rate for a target audience, you could just encode the 
clip using a slower target audience setting. This does not give you the precise 
control you have when choosing a new bit rate, but it may be adequate in 
many circumstances. Suppose you want to combine RealVideo with a 50 Kbps 
RealPix slide show for DSL/cable modem connections. You could lower 
RealVideo’s lowest DSL rate by 50 Kbps, or simply encode the RealVideo clip 
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at the standard LAN speeds. The modified DSL setting gives you a 175 Kbps 
clip that is only marginally better than the 150 Kbps clip you get from the 
default LAN option.

Setting RealVideo Advanced Features
RealProducer has several options that affect how it encodes RealVideo clips. 
These options can improve clip quality, but also degrade it if used improperly. 
Some options also affect encoding speed. Choose Options>Preferences to 
display the preferences dialog, which has three panes of options.

Note

Unless noted otherwise, all RealVideo options are 
compatible with each other and can be used when 
encoding video from a source file, a media device, or a 
live broadcast.

Using RealVideo Filters

The Video Filter pane of the preferences dialog has several filtering options you 
can use when encoding RealVideo. These filters remove artifacts that appear 
in the encoded clip because of the methods used to create the source video.

Figure 7: RealVideo Filter Preferences Dialog
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Noise Filters

A by-product of poor quality in one or more links in the video production 
chain, video noise (which has nothing to do with the audio quality) can distort 
the encoded clip. These distortions are similar to the “snow” that often shows 
up in TV signals received over an antenna. The source of the noise is typically 
hardware, such as the video tape, capture card, or camera. Using professional-
quality equipment and media helps eliminate video noise at the source. If your 
source video is high quality to start with, you won’t need the noise filters.

Additional Information
See the video preparation chapter in RealSystem G2 
Production Guide for tips on producing high-quality 
video.

Low Noise Filter

If your video input has a small amount of noise, turn on the low-noise filter. 
Because it has a small impact on processing power and won’t degrade a video’s 
appearance, the low noise filter is safe to leave on at all times. It’s better 
practice, though, to use it only when necessary.

High Noise Filter

If noise greatly distorts the source video, try the high noise filter. Although 
optimized for Pentium MMX machines, the high noise filter can nonetheless 
add 30% or more to the encoding time. It can also remove slight details, 
making highly textured surfaces look more smooth. For these reasons, never 
use the high noise filter when it is not needed.

Resize Filters

RealProducer’s Options>Video Settings... command lets you resize video as 
you encode it. On the Video Filter tab of the preferences, you can select 
whether to do this as a fast resize or a high-quality resize. These resize options 
affect the video only when you make it smaller. They tell RealProducer to 
throw out video data using a quick method (fast resize), or through a complex 
analysis (high-quality resize).

A fast resize has a small impact on encoding time, but the resulting image may 
have some distortion. A high-quality resize results in a superior image, but it 
may double or triple the encoding time because it carefully analyzes the video 
source before resizing. Because of its impact on speed, the high-quality resize 
filter is not recommended for broadcasts.
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Inverse-Telecine Filter

The Inverse-Telecine filter is for cinematic film that was transferred to NTSC 
video, whether the VHS or BETA version. Film is usually photographed at 24 
frames per second (fps), whereas the NTSC standard is 30 fps. The film-to-
video conversion (called “telecine”) duplicates some frames to bring the film 
input up to the NTSC frame rate. American theatre-release films transferred 
to video, for example, undergo the telecine process.

Use the inverse-telecine filter when encoding NTSC video that was transferred 
from film and has a frame rate of 25 to 30 fps. (The filter is not necessary if 
the video frame rate is below 25 fps.) The filter strips out redundant frames, 
letting RealProducer focus on image quality. This improves the clip’s overall 
look. Although the inverse-telecine filter is safe to use on all input, it slows 
performance marginally and should be used only when the source is NTSC 
video that originated from film.

Note

PAL video, which is widely used in Europe, does not 
require the inverse-telecine filter because the conversion 
from 24 fps film to 25 fps PAL does not use the telecine 
process.

De-interlace Filter

The de-interlace filter removes jaggedness in interlaced NTSC or PAL video. A 
video camera running at 30 frames per second captures the odd-numbered 
lines of a frame in 1/60th of a second, and the even-numbered lines in the next 
1/60th of a second. It then interlaces the two to create the frame. Because half 
the frame’s lines are captured a fraction of a second later than the other half, 
fast-moving objects may appear jagged, the result of the object advancing 
slightly within 1/60th of a second. Figure 8 illustrates this jaggedness in a 
detail of an interlaced video.
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Figure 8: Jaggedness in an Interlaced Video (detail)

Figure 9 shows the jaggedness removed with the de-interlace filter.

Figure 9: Jaggedness Removed with the De-interlace Filter (detail)

Optimized for Pentium MMX processors, the de-interlace filter has a modest 
impact on encoding speed, but is useful only for interlaced source video that is 
240 lines or higher. Typical source video used for television is 480 lines high. If 
you digitize the video with a video capture card that captures at 240 lines high 
or less, the card throws out either the odd or the even lines, de-interlacing the 
video itself. The de-interlace filter is safe to leave on, though, because 
RealProducer never applies it to a video less than 240 lines high.

Setting RealVideo Codec Features

The Video Codec pane of the preferences dialog includes several encoding 
options you can use with RealVideo. It also lets you select which RealVideo 
codec encodes your clips. These options affect the quality of RealVideo clips by 
modifying RealProducer’s encoding methods.
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Figure 10: RealVideo Codec Preferences Dialog

RealVideo Codec

The top of the Video Codec pane has a pull-down menu that lets you choose 
between three RealVideo codecs. The default choice is the RealVideo 8.0 codec, 
but you can also choose one of two RealVideo G2 codecs. The codec you select 
encodes all of a clip’s SureStream streams. You cannot encode half the streams 
with the RealVideo 8.0 codec, for example, and the other half with a RealVideo 
G2 codec.

RealVideo 8.0

The default RealVideo 8.0 codec results in visual quality markedly superior to 
that of the RealVideo G2 codecs. It requires more processing power, though, 
so encoding a clip with it takes longer than encoding the clip with a RealVideo 
G2 codec. RealPlayer 8.0 and higher can play RealVideo 8.0 clips. Earlier 
RealPlayers attempting to view a RealVideo 8.0 clip are prompted to auto-
upgrade to RealPlayer 8.0. RealNetworks recommends using this codec unless 
you need faster encoding performance during broadcasts, or must reach older 
versions of RealPlayer.
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Note

Most users upgrade their RealPlayers soon after a new 
version is released, so it is generally safe to use the 
RealVideo 8.0 codec.

RealVideo G2 Codecs

The RealVideo G2 codecs are older codecs used by RealProducer G2 and 
RealProducer 7. These codecs are faster than RealVideo 8.0, but their visual 
quality is poorer. Use them for faster encoding during broadcasts, or if you 
must reach RealPlayers that cannot upgrade to Release 8:

• RealVideo G2 with SVT

The RealVideo G2 with SVT codec is compatible with RealPlayer version 
6.0.6 or higher. RealPlayers with lower version numbers are prompted to 
auto-upgrade to the latest RealPlayer before viewing the clip.

• RealVideo G2

The RealVideo G2 codec without SVT is compatible with RealPlayer G2, 7, 
and 8. It is not compatible with RealPlayers version 5.0 or earlier.

How SVT Works

The RealVideo 8.0 and RealVideo G2 with SVT codecs include Scalable Video 
Technology (SVT). This technology removes a stumbling block of streaming 
media by letting you encode clips at high frame rates for fast machines 
without concern that slower machines might not keep up. SVT even works 
when delivering clips with Web servers.

RealVideo’s variable frame rate means one scene may be encoded at 7 fps, 
while another is at 15 fps. High frame rates take a lot of processing power to 
decompress. Although fast PCs handle high frame rates well, slower PCs may 
have trouble. With SVT, RealPlayer can lower the frame rate “on the fly” to 
keep the PC’s CPU from sputtering. So although a certain scene is encoded at 
15 fps, it may play on some RealPlayers at 8 fps, for example, if those 
RealPlayer machines lack the power to decompress 15 fps.

Loss Protection

The loss protection feature adds error correction data to RealVideo streams, 
helping them maintain quality in lossy environments. RealProducer adds as 
much error correction data as it can without taking away any video quality. 
Although you’ll get more benefit from this feature when streaming on the 
Internet than on an intranet, it is safe to leave loss protection on for all 
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encoded content. This feature has a negligible impact on RealProducer’s 
encoding speed.

Variable Bit Rate Encoding

Variable bit rate (VBR) encoding varies a RealVideo clip’s playback bit rate, 
giving more bandwidth to scenes that are hard to compress, and less to scenes 
that are easy. Compatible with SureStream and broadcasting, VBR encoding 
generally provides superior video quality to constant bit rate (CBR) encoding, 
which RealProducer uses if you do not select the VBR option. VBR makes the 
most difference in videos that have a mix of high-action and low-action scenes 
because it can steal bandwidth from low-action areas to give to high-action 
areas. This is particularly useful for improving video quality at low bit rates.

To illustrate how VBR encoding works, suppose you encode a video for a 
DSL/cable modem audience at 225 Kbps. With CBR, the video gets 225 
Kilobits of encoded data each second. With VBR, though, each second of video 
may be encoded at a different rate. One second may have 150 Kilobits of data, 
for example, while another second has 300 Kilobits. The VBR clip will have a 
streaming bit rate of 225 Kbps, though, just like a CBR clip. So you do not need 
to worry that a VBR clip will underuse or overload a connection’s bandwidth.

Think of the playback bit rate of a VBR clip as a waveform with peaks and 
troughs, as illustrated in Figure 11. RealProducer preloads the extra Kilobits 
required to play upcoming peaks in the preceding troughs. So one low-action 
scene that requires 150 Kilobits of data per second actually streams at 225 
Kbps, carrying with it an extra 75 Kbps that RealPlayer uses in an upcoming 
fast-action scene. The flat line at 225 Kilobits in Figure 11 represents this 
streaming bit rate.

Figure 11: Variable Bit Rate Peaks and Troughs
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A VBR-encoded video that starts with a high action scene needs a spike of 
bandwidth right away. If there are no preceding troughs to carry this data, 
RealPlayer has to buffer the clip longer. That means it may take the VBR clip 
longer than a CBR clip to start playing back. RealProducer lets you set the 
maximum time RealPlayer needs to buffer the clip, though, to ensure that the 
initial buffering time remains acceptable.

Additional Information
See “Setting VBR Maximum Start-up Latency” on page 
34 for information on changing RealPlayer’s initial 
buffering time.

Two-Pass Encoding

With two-pass encoding, which is used only when encoding from a digitized 
source file, RealProducer runs through the entire source video once to gather 
information about how best to encode the streaming clip. It then makes a 
second pass to encode the streams. Two-pass encoding can substantially 
increase clip quality, but it requires more encoding time. The first pass takes 
about as long as it would to encode the source file for one target audience.

Although two-pass encoding helps when you use constant bit rate encoding, it 
provides greater benefit for variable bit rate (VBR) encoding, which is 
described above. With two pass encoding, RealProducer can analyze the entire 
video file to determine how best to vary the playback bit rate through the 
length of the clip. Without two-pass encoding, RealProducer sequentially 
analyzes small sections of the source file during encoding, creating a string of 
VBR sections within the clip.

Using RealVideo Advanced Codec Features

The Advanced pane of the preferences dialog has options that affect RealVideo 
encoding. You should change these only with caution because they can greatly 
affect how well the clip streams.
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Figure 12: RealVideo Advanced Codec Preferences Dialog

Setting VBR Maximum Start-up Latency

The VBR Maximum Startup Latency field affects only RealVideo clips encoded 
with a variable bit rate (VBR), which is described in “Variable Bit Rate 
Encoding” on page 32. A VBR video that starts out with a high-speed scene 
needs more initial buffering because the first scene is encoded at a playback 
bit rate higher than the audience connection speed. Because RealServer can’t 
stream the scene faster without overloading the connection bandwidth, it 
streams it longer to deliver the extra Kilobits needed.

The latency field determines how long RealPlayer viewers may have to wait 
before a VBR video starts back. The default value of 15 seconds means that no 
matter how complicated the video’s first scene, RealProducer will encode it so 
that it requires no more than 15 seconds to start playing. The field sets a 
maximum value only, and RealVideo VBR clips may start playback sooner. You 
can change the maximum to a whole value from 5 seconds to 25 seconds.

The value of 15 seconds is RealNetworks’ recommendation. Keep in mind that 
this represents 15 seconds of clip data buffering, and does not include the 
time it takes to launch RealPlayer, find the host RealServer, send the request, 
and receive the host’s response. If a low start-up time is critical, lower the 
latency time to 10 seconds, for example. For comparison, constant bit rate 
clips are encoded to have a latency of about 5 seconds. If initial image quality 
is crucial, you can raise the latency time, but this may cause restless viewers to 
stop the presentation before it begins playback.
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Specifying Maximum Time Between Keyframes

RealProducer encodes full data for a frame in a keyframe. Successive frames 
encode just the data that describes how they vary from the preceding frame, 
starting with the keyframe. The Maximum Time Between Keyframes field is set 
initially to 10,000 milliseconds, meaning a constant or variable bit rate 
RealVideo clip has a keyframe at least every 10 seconds. The main reason to 
change the maximum rate is to lower it, although you should do this with 
caution. Lowering the rate generates more key frames for clips and provides 
several benefits:

• Minimizes distortion when streaming in a lossy environment.

• Improves RealPlayer’s ability to seek to specific points in the RealVideo 
timeline.

• Adds flexibility for editing RealVideo clips through File>Edit RealMedia 
File. You have to cut a RealVideo clip at a keyframe, for example. More 
keyframes means more precise control over where the cut occurs.

Because keyframes encode much more data than other frames, though, 
lowering the maximum time between keyframes can lower the clip’s image 
quality if you do not also raise the clip’s streaming bandwidth. If you change 
the keyframe rate, test the clip quality to determine if the modification 
produced the desired results.

Additional Information

See “Changing RealVideo’s Target Bit Rate” on page 23 
for information on raising a clip’s streaming bandwidth.

Viewing Statistics
After you record a clip, the confirmation dialog has a View Statistics button 
you can click to pull up a wealth of information about the clip. Even while 
RealProducer encodes the clip, you can watch statistics in real-time with 

View>Statistics. Although it’s easy to pass these dry numbers by, they tell you a 
lot about your clip, including which speeds they’re encoded for. The statistics 
dialog has up to three panes:

• The General pane appears only for RealVideo clips. It has combined 
statistics for the visual track and soundtrack.

• The Audio pane lists statistics for the encoded audio. It appears for 
RealVideo and RealAudio clips.
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• The Video pane, which appears only for RealVideo clips, lists additional 
information about the visual track encoding.

Basic Recording Statistics

Figure 13 shows the basic recording information that appears at the top of the 
General, Audio, and Video panes of the statistics dialog. This example is for a 
SureStream RealVideo clip encoded with RealProducer Plus and targeting 
seven audiences.

Figure 13: Recording Information

As shown in Figure 13, the information at the top of each statistics pane 
indicates the basic choices made for audio format and video quality. When you 
view this information while encoding a file, the Clip Position field shows 
precisely where in the file’s timeline RealProducer is encoding the clip. If it’s 
two minutes and thirty seconds into the file, for example, Clip Position reads 
00:02:30. When you broadcast, this field is labeled Duration, and shows how 
long the stream has been broadcasted.

The Time Remaining field indicates how much longer RealProducer will take 
to finish the encoding. RealProducer may finish faster or slower depending if 
other computer processes use the CPU during the encoding. The Time 
Remaining field doesn’t work when broadcasting or encoding a clip from a 
media device. In these cases, the encoding lasts until you turn the input off.

The Real-Time Performance field shows a percentage value that indicates 
overall codec performance. The lower the percentage, the faster the codecs are 
working. If RealProducer takes just under five minutes to encode a clip that 
lasts five minutes, the performance is around 100%. On a fast machine, 
performance will more likely be a lower value. If it takes four minutes to 
encode the five-minute clip, performance is around 80%. On a slow machine, 
the performance value may go above 100%. Taking six minutes to encode a 
five-minute clip, for instance, delivers a performance of around 120%.
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Note

Performance is a measure of codec speed only. It does 
not take into account the time required for other 
activities such as disk reads and writes.

A performance over 100% is not a problem when you encode from a file. This 
just means it takes longer to encode the clip than to play the original file start 
to finish. Performance over 100% is a problem when you encode from an input 
device or broadcast a stream, however. It means RealProducer cannot encode 
the input as quickly as it comes in. For broadcasts, RealNetworks recommends 
a performance of 80% or less to ensure smooth operation. If necessary, you can 
boost performance by one or more means:

• Run RealProducer on a faster machine.

• Reduce the number of SureStream streams.

• Use the RealVideo G2 with SVT codec instead of the RealVideo 8.0 codec. 
(See “RealVideo Codec” on page 30.)

• Turn off filters that may slow encoding time:

• High Noise Filter (see page 27)

• Resize Filters (see page 27)

• Two-Pass Encoding (see page 33)

Tip
Before broadcasting, carry out a test run to check how 
well RealProducer performs. In your test, RealProducer 
should send clip data to RealServer. RealServer does not 
need to broadcast the streams to more than a few 
RealPlayers, though.

General Statistics

The General statistics pane, the main part of which is shown in Figure 14, 
appears only for RealVideo clips. It lists the total bit rate, video bit rate, audio 
bit rate, frame rate, and buffer time for each stream in the clip. Figure 14 is for 
a SureStream RealVideo clip targeting seven audiences.
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Figure 14: General Statistics Screen

Note the number of audience targets. Even though the clip is encoded for 
seven targets, 11 show up in this statistics dialog, which illuminates the inner 
workings of SureStream. Look at the two entries for Corporate LAN. They 
both use a 32 Kbps RealAudio codec, but the first has a total bit rate of 152.5 
while the second has a 104.9 Kbps rate. The second stream is the duress 
stream that RealServer uses if the connection bogs down and it can’t stream 
the full 152.5 Kbps of data. The audio stays the same, but as you can see from 
the Frame Rate column, the frame rate drops from 13.9 fps to 9.9 fps when 
RealServer downshifts.

Additional Information
For more on duress streams, read “Duress Streams” on 
page 4.

If you look at these statistics from top to bottom, you can see exactly how the 
clip compensates if it starts to lose bandwidth. Each time it needs to 
downshift, the clip reduces bandwidth consumption with one or a 
combination of three things: 

1. Switching to a lower bandwidth RealAudio codec.

2. Switching to a visual track that has a lower frame rate.

3. Switching to a visual track that has reduced clarity.

The last column of the statistics pane lists the time in seconds that RealPlayer 
takes to buffer a stream before playing it. A value of 3.5, for example, means 
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RealPlayer starts to play the clip 3.5 seconds after it begins to receive clip data, 
assuming that the connection’s bandwidth holds up and there’s no network 
congestion. Ideally, you want buffering to be under 15 seconds. This buffering 
occurs only when the clip begins to play, not during downshifting or 
upshifting to other SureStream streams.

Audio Statistics

The Audio pane, shown in part in Figure 15, appears in the statistics dialog for 
RealVideo and RealAudio clips. It gives the frequency responses of the 
RealAudio codecs used to encode the clip. “RealAudio Codec Reference” on 
page 16 lists the frequency responses for all RealAudio codecs.

Figure 15: Audio Statistics Screen

Like the general real-time performance value shown at the top of each pane, 
the real-time performance value for each codec shows how quickly 
RealProducer created each RealAudio stream. Any value over 100% means 
RealProducer could not encode the track as fast as the data came in.

Note

As noted in “Basic Recording Statistics” on page 36, an 
overall performance of 80% or higher can cause 
problems when you encode live input.

Video Statistics

Illustrated partially in Figure 16, the Video pane displays only for RealVideo 
clips. It gives the video bit rate and frame rate for all streams, just like the 
General pane. In addition, it provides a quality index and information about 
real-time performance.
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Figure 16: Video Statistics Screen

The quality index is useful only during live broadcasts. A value of 100 
indicates the codec could keep up with the data coming in. A value below 100 
means the computer does not have enough processing power to encode the 
stream in real-time. In this case, the codec compensates by dropping frames 
from the stream. The real-time performance value for each video encoding 
tells how quickly RealProducer created each visual track. Any value over 100% 
means RealProducer could not encode the track as fast as the data came in. 

Note

As noted in “Basic Recording Statistics” on page 36, an 
overall performance of 80% or higher can cause 
problems when you encode live input.
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